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Preface \

Preface

Software Philosophy

TDT's philosophy on software development is simple. We design
comprehensive drivers that control all aspects of the hardware from common,
high-level programming languages. With minimal programming, TDT's
hardware drivers enable scientists to design customized experiments. This
approach works quite well in most research environments. With TDT's software,
scientists no longer face the arduous task of programming each experiment in
low-level machine code. Furthermore, they avoid the limitations imposed by
"turn-key" software.

However, there has been an increasing demand for an interactive environment
that allows the auditory researcher to design custom signals, present stimulus
signals, and gather response data. In response to this need, TDT has raised its
approach to software development to a higher level by designing a suite of
powerful and flexible software packages. This suite incl&ig&en BioSig
andPsychoSig SigGen offers a signal generation environment that is above the
level of 'C' or Pascal programming. It is a complete stimulus design application
that will become the basis for a suite of TDT programs specifically developed
for auditory research. BioSig, the first of this suite of programs, provides the
user with an easy-to-use, yet flexible, means for presenting stimulus signals and
collecting response data. PsychoSig provides a quick and easy means of
designing and running forced-choice psychoacoustic experiments.

Traditionally, systems designed to present stimulus signals and acquire response
data have been of two types: "turn-key" clinical systems and custom systems
written from scratch. With "turn-key" systems, type and frequency of stimulus
signals are restricted. Such systems are good for clinical settings, but are too
restricted for auditory research. Custom systems, while providing the ability to
control all aspects of stimulus presentation and data acquisition, often require
tedious hours spent programming and debugging software. Because PsychoSig
utilizes custom signals generated in SigGen, it allows users to design and present
complex stimulus signals without writing a line of code.

As with all software applications, the SigGen suite of applications have their
inherent limitations. For this reason, TDT still maintains as its highest priority
continued support of its software drivers.
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PsychoSig versus Experimenter

PsychoSig was designed to be a Windows 95 alternative to TDT's experiment
development software, Experimenter. The software allows researchers to
quickly design forced-choice psychoacoustic experiments through the use of
point and click graphical user interface.
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Using this Manual

ThePsychoSig User's Guids divided into two parts:
m Partl PsychoSig Fundamentals

m Part2 lllustrative Examples

PsychoSig Fundamentals

Part 1, PsychoSig Fundamentals, presents all the basic PsychoSig concepts
necessary to design and run forced-choice psychoacoustic experiments. The
document guides you through the process of experiment configuration and
execution. It also serves as a general reference tool. The guide provides:

B General information about PsychoSig
B Basic information about PsychoSig's features

B A detailed explanation of the processes of experiment setup and execution

General Information

General Information includes a description of the purpose and uses of
PsychoSig, an overview of the experiment configuration and execution process,
and PsychoSig installation instructions. General information is presented in the
following chapter:

B Chapter 1 Introduction

Basic Information

Basic information includes definition of terms, "Getting Started" instructions,
and a brief tour of the PsychoSig main window. Basic information is provided
in the following section:

B Chapter 2 Learning the Basics

Study Design, Execution, and Data
Analysis

The steps required to design and run an experiment are listed below along with
their associated chapter.

Step Chapter

1 Designing the experiment Chapter 3 Designing Experiments
2. Running the experiment Chapter 4 Running Experiments
3. Data Collection and Storage Chapter 5 Data Collection
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lllustrative Examples

Some typical examples of forced-choice experiment design and execution are
presented in:

B Chapter 6 Quick Start Examples

Document Conventions

This manual uses conventions that make it easy to locate information.

The Table of Contents

The Table of contents contains the top three levels of section headings. Itis a
quick way to reference the topics covered in this manual.

Important Points

! Key points are emphasized with an exclamation point in the margin.
References
See section x for References to other sections are made in the left margin for quick access.

further details

How to...

Step-by-step instructions for performing a task are always headed by a “To...”
line. Single-line instructions use tpe bullet, while multiple-line instructions
are numbered.

To find a topic in this manual
» Locate the topic in the Table of Contents.
or

1. Open to the first page.

2. Read until the topic is found.
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Other Sources of Information

See Using PsychoSig
Help in Chapter 2 for
further details

If you cannot find the information you need in this manual, there are several
other sources for information.

The PsychoSig Help File

The PsychoSig on-line help file contains answers to the most commonly asked
guestions about the program. This file is updated regularly by TDT, and can
be downloaded from our ftp site.

ReadMe File

Look in the PsychoSig directory for a README.TXT file. This file has
information about the version of PsychoSig that you have installed, including
known bugs and information that came too late to be included in this manual.

Technical Support

TDT provides phone and electronic mail support for users of PsychoSig. Please
be near your computer when you call so we can best assist you with your
guestions.

PsychoSig User's Guide
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Chapter 1 Introduction

Welcome to PsychoSig, TDT's windows-based tool for forced-choice
psychoacoustic experiment setup and execution.

What Is PsychoSig?

PsychoSig is a windows-based software package designed to configure forced-
choice psychoacoustic experiments quickly and easily.

PsychoSig Capabilities

PsychoSig has been designed to meet the needs of experimenters working in the
area of forced-choice psychoacoustics. PsychoSig has been designed with the
following features:

Multiple intervals Binaural stimuli

Dynamic tracking Statistical analysis of data

System security

[ |
[ |

Additive and multiplicative tracking B System calibration
Step size control u
[ |

Multiple conditions SigGen file support

Auditory and visual feedback

Multiple Intervals

PsychoSig allows you to design experiments that present two to six intervals per
trial.

Dynamic Tracking

PsychoSig employs dynamic tracking of the experimental variable. You specify
the initial variable value, the maximum variable value, the minimum variable
value, the tracking method, the step size, and the number of correct and incorrect
responses required to increment or decrement the variable. PsychoSig will
automatically vary the stimulus based on your specifications and the subject’s
responses.

Additive and Multiplicative Tracking

PsychoSig allows you to vary the experimental stimulus in a linear fashion using
additive tracking. PsychoSig also provides a method for varying the
experimental stimulus in an exponential fashion through the use of multiplicative
tracking.
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Step Size Control

PsychoSig provides two step sizes: initial step size and final step size.
PsychoSig modifies the experimental stimulus according to the initial step size
until a user-specified number of reversals occur, upon which PsychoSig
implements the final step size.

Multiple Conditions

PsychoSig allows for the presentation of the experiment in multiple conditions.
Conditions are defined through use of SigGen variables.

Auditory and Visual Feedback

Using PsychoSig, you may customize optional feedback for both correct and
incorrect responses. You can present auditory feedback, visual feedback, or
both in your experiments.

Binaural Stimuli

PsychoSig allows you to present one or two channels of stimuli. You can easily
create monaural and binaural experiments.

Statistical Analysis

As data are collected, summary statistics such as mean, standard deviation, and
standard error are computed and stored in a dataddéfije).

System Calibration

PsychoSig’'s Calibration dialog box provides a means for calibrating your system
through use of a pure tone or through use of the actual stimulus signal.

System Security

PsychoSig may be operated in one of two modes:mode orconfiguremode.

When in run mode, PsychoSig allows the user to run experiments, only. When in
configure mode, users may configure experiments. Access to configure mode is
restricted through the use of a configure mode password.

SigGen File Support

PsychoSig has been designed to work with TDT's signal generation package,
SigGen. Stimulus signals may be created easily via SigGen and assigned to
PsychoSig experiments.

Hardware Support

PsychoSig supports TDT's System Il instrumentation. The minimal system
consists of a digital to analog converter (DAL, DD1, PX1(PD1), or DA3) and
either a speaker (MS1) or a headphone buffer (HB6). An anti-aliasing filter
(FT5 or FT6) and a programmable attenuator (PA4) are highly recommended.
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Who Can Use PsychoSig?

Anyone with a PC, Windows 95, TDT System Il instrumentation, and SigGen
can use PsychoSig. PsychoSig was designed to meet the needs of auditory
scientists performing forced-choice psychoacoustic experiments.

How to Use PsychoSig

PsychoSig is used in conjunction with TDT's signal generation package, SigGen.

[ SigGen ]

| Binary File | | SigGen File |
4

/
/
/
/
/

I
|
|
|
( Custom Application J ( BioSig J [PsychoSig ]
I
|
|
|
|
1

Output Output Output

PsychoSig enables you to quickly design and execute forced-choice
psychoacoustic experiments. The process is as follows:

1. Design the stimulus signal using SigGen.

TDT's signal generation package, SigGen, provides a simple, yet powerful,
means for designing your stimulus signals. Signals generated with SigGen
may be saved as SigGen filesi@files) for use with other TDT signal
processing applications, including PsychoSig.

2. Design the psychoacoustic experiment using PsychoSig.

PsychoSig is an easy-to-use tool for designing and executing forced-choice
psychoacoustic experiments The process is relatively simple:

a. Assign the SigGen stimulus signal.
b. Configure the experiment in PsychoSig.
c. Run the experiment.

d. Analyze and process the response data.

PsychoSig User's Guide
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Before You Begin

With a bit of preparation, designing experiments with PsychoSig is quick and
easy.

What You Need

See your Microsoft B Windows 95 fundamentals
Windows 95 . _ .
documentation. You should be comfortable with Windows basics.

[ |
B Signal processing
[ |

See Digital Signal A basic knowledge of signal processing is necessary. You should
Processing understand the parameters necessary for specification of a signal in the

éhaﬁ;ﬁf'cl’”—s’ frequency and time domains.

) Basic SigGen concepts
See SigGen User's

Guide, Chapter 2, B You should be comfortable with signal design using SigGen and should
"How to Build and recognize the tern8igGen IndexSGl) anddynamic variable

Present SigGen

Signals."

Installing the Software

Requirements

In order to run PsychoSig, you must have the following:

TDT's AP2 Array Processor

APOS ONBOARD software (latest version available)

Microsoft Windows 95

Super VGA graphics adapter (800 x 600) (1024 x 768 recommended)
TDT's XBUS hardware (sddardware Configurationbelow)

TDT's SigGen software

Installation

To install PsychoSig

» Runa:\install.exe

" PsychoSig will run under Windows 3.1 with the installation of Win32S.DLL. A bug in Win32S, however,
does not display bitmaps correctly. Contact TDT if you wish to operate PsychoSig under Windows 3.1.

PsychoSig User's Guide
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Hardware Configuration

PsychoSig was designed to work with TDT's powerful and flexible System Il
hardware. In addition to the AP2 Array Processor, to run PsychoSig, your
System Il configuration must include the following XBUS equipment:

B Digital to analog converter (DAL, DD1, PX1(PD1), or DA3)
B Headphone buffer (HB6) or monitor speaker (MS1)

The following additional XBUS devices are highly recommended for best
performance of your experimental setup:

B Anti-aliasing filter (FT5 or FT6)

B Programmable attenuator (PA4)

PsychoSig User's Guide
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Basic Terminology

Before using PsychoSig, you must be familiar with basic psychoacoustic terms.
These terms are defined in this section, beginning with the lowest level terms
such aexperimental variabland proceeding to higher level terms such as
condition

Experimental Variable

For more information Theexperimental variablés the signal parameter of interest in the experiment.
about dynamic For eaclcondition the experimental variable is systematically varied across
variables, see the trials. The experimental variable is defined in SigGen dgramic variable

SigGen User’s Guide.

Experimental Stimulus

The experimental stimuluis the stimulus signal which varies tieperimental
variable over successiveials.

Standard Stimulus

A standard stimulusgs any signal which holds all of its parameters constant over
successivérials within a specificcondition

Interval

An interval corresponds to the temporal presentation of a stimulus within each
trial. For example, if a trial consists of the presentation of two stimuli, an
experimental stimulus and a standard stimulus, it must consist of two intervals.
That is, there must be a temporal location for a first stimulus and a second
stimulus. Intervals are graphically presented to the user in PsychoSig through
interval buttons. Thus, there is one interval button for each stimulus presented.

Trial

In PsychoSig, &ial consists of two or mor@tervals Typically, a trial consists

of two intervals, to which the experimental stimulus and the standard stimulus

are randomly assigned. During each trial, both stimuli are presented to the
subject and a response is elicited. Thus, for each trial there is one corresponding
subject response. In PsychoSig, the subject responds by selecting the interval
that is believed to be correct.

PsychoSig User's Guide
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Works

For more information
about the SigGen Index,

see the SigGen User’s
Guide.

Condition

An experiment may be conducted in one or ntanadition Conditions are

created by systematically varying stimulus parameters of the standard stimulus.
The parameters of the standard stimulus are held constant during a specific
condition while the experimental stimulus varies. A condition is analogous to
theSigGen IndexSGl).

How PsychoSig Works

For more information
about designing SigGen
Signals, see the SigGen
User’s Guide.

PsychoSig User's Guide

PsychoSig enables you to set up and run forced-choice psychoacoustic
experiments using custom designed stimulus signals. The process is as follows:

1. Design the stimulus signal using SigGen.

2. Setup and run the experiment using PsychoSig.

Designing the Stimulus Signal

TDT's signal generation package, SigGen, provides a simple, yet powerful,
means for designing your stimulus signals. Signals generated with SigGen may
be saved as SigGen filesiffiles) for use with other TDT signal processing
applications, including PsychoSig.

Setting-up and Running Experiments

PsychoSig is an easy-to-use tool for setting-up and running psychoacoustic
experiments. The process is relatively simple:

1. Configure PsychoSig.

2. Present the stimulus conditions.
3. Acquire response data.
4

Analyze and process the response data.

Configure PsychoSig

Configuration settings include:
Specification of stimulus signal
Variable definition

Specification of experiment parameters
Specification of interval parameters

Feedback specification

Subject identification
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Present the Stimulus Conditions

For definition of terms PsychoSig allows the user to design experiments that dynamically vary an

used in this section, see  experimental variable in one or more experimental conditions. PsychoSig

the previous section reads the SigGen stimulus file and determines the number of conditions (SGls)

Basic Terminology. based on the variable definitions contained in the file. You may choose which
experimental conditions will be executed for a given experiment. PsychoSig
will execute conditions until all conditions have been presented or until the
experiment is aborted.

Begin Acquiring Response Data

PsychoSig collects response data for é¢eah Summary data for each
conditionis saved in a data filedatfile).

Analyze the Response Data

Response data is saved in a PsychoSig datadééfile). You may:
B View data graphically as it accumulates.

B View data in text format as it accumulates.

B View data in any text editor.

Getting Started

Starting PsychoSig

_ng_ To start PsychoSig.
» Choose PsychoSig from the Windows 95 Start menu.
or
» Double-click the PsychoSig icon.
The PsychoSig Startup dialog box opens.

PzychoSig Startup El

seeneener e e e s ae e emeneane DK

) Configure an Experiment

Pazavaond: |

PsychoSig User's Guide
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PsychoSig Modes

PsychoSig works in two modesin modeandconfigure mode

Run Mode

Run mode is designed to meet the needs of subjects. In run mode, the following
functions are enabled:

Open an experiment

B Calibrate the system
B Run an experiment
B Exit PsychoSig

PzychoSig Startup E3

0K

O Configure an Experiment Cancel

Pazzvaond:

To run PsychoSig in Run Mode
1. Click ® Run an Experiment.
2. Click OK.

The PsychoSig Run Experiment window will appear.

Configure Mode

Configure mode is designed to meet the needs of experimenters. Only those
users with access to the configure mode password can log in to configure mode.
When in configure mode, the user can perform all of the functions available in
run mode, plus the following:

Assign stimulus signals to an experiment
Define the experimental variable

Define intervals

Set experiment parameters

Define feedback

Enter subject information
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Important
information for new
users!

Pzpchobig Startup X

O Run an Experiment

& Configure an Experiment

Pazzward: ||

To log in to configure mode

1. Click ® Configure an Experiment.
2. Enter the configure mode password.
3. Click OK.

The PsychoSig Configure Experiment window will appear. You now will have
access to all PsychoSig experiment design functions.

The Configure Mode Password

PsychoSig uses a simple security system to restrict access to experiment
configuration. To obtain access to all experiment setup functions, the user
must log in using theonfigure mode passward

The configure mode password BDT”. Share this password only with those
to whom you wish to grant configure mode access.

PsychoSig User's Guide
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Getting to Know the PsychoSig Main Windows

The Run Experiment Window

Upon opening, the Run Experiment window appears as below.

? Untitled - Run Experiment

Title Bar

Tool Bar

File Stmuli Experiment Yiew Help

BEFIEELE]

Interval 1

Intervsal 2

\ /

Interval Buttons

Experiment Window

For Help, prezs F1

LI I T4

The Run Experiment window contains the following sections:

Title Bar Displays the current PsychoSig file followed by “Run Experiment.”

Menu Bar Contains a list of menus used to run experiments.

Tool Bar Provides easy-to-use buttons for most menu functions.

Experiment Window Presents the experiment as seen by the subject.

Interval Buttons

response.

PsychoSig User's Guide

Included in the Experiment Window are interval buttons.
Each button represents a trial interval and may be used by the subject to select a
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The Configure Experiment Window

Upon opening, the Configure Experiment window appears as below.

Title Bar Menu Bar Tool Bar

,_-»'}_Untilled - Configure Experiment

File Setup Experiment

View Help

O[] [[e]x [#] #=| x[=]@)] |S] 2]V |

b=1E] <|<<| >>| >|

Output Window

Interval 1 Interval 2

\ /

Interval Buttons

Experiment Window

For Help, press F1

C I T 14

The Configure Experiment window contains the following sections:

Title Bar Displays the current PsychoSig file followed by “Configure
Experiment.”

Menu Bar Contains a list of menus used to configure and run experiments.
Tool Bar Provides easy-to-use buttons for most menu functions.

Output Window Displays the results of an experiment.

Experiment Window Presents the experiment as seen by the subject.

Interval Buttons Included in the Experiment Window are interval buttons.

Each button represents a trial interval and may be used by the subject to select a
response.

PsychoSig User's Guide
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Using the PsychoSig Menus

PsychoSig provides the user with a full set of menu commands. From these
menu commands, you can configure and run experiments.

The File Menu
Running Mode Configure Mode

DOpen... Ctrl+0 Hew Ctrl+N
Print... Cil+P Open... Ctrl+0

. . Save Ctrl+5
Print Preview

i Save As___
Print Setup...
1 Test Prnt._. Ctrl+P
E ! Est -pl?"ﬁ. Print Preview
£ BT Print Setup...
Exit 1 tester. PA

E xit

From the File menu, you may create new experiments, open existing
experiments, save experiments, and print result data.

New Creates a new PsychoSig file.

Open Opens an existing PsychoSig file.

Save/Save As...Saves a PsychoSig File.

Print Prints the data text file.

Print Preview Displays how the data text file will be printed.

Print Setup Accesses the Windows Print Setup dialog box, from which you
may configure your printer.

List of Most Recently Used Files Displays the most recently used PsychoSig
files so that you may quickly access frequently run experiments.

Exit Exits PsychoSig.

PsychoSig User's Guide
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The Setup Menu

Configure Mode Only

B

Signal
Yariable
Expenment
Intervals
Subject
Feedback

The Setup menu provides commands that allow you to set up and run an
experiment.

Signal Opens the Open dialog box, from which you specify the SigGen signal
(.sigfile) for use in the experiment.

Variable Opens the Dynamic Variable Settings dialog box. From this dialog
box you enter variable and tracking information.

Experiment Opens the General Experiment Parameters dialog box, from which
you may define general experiment parameters, timing intervals, and result files.

Intervals Opens the Interval Properties dialog box. From this dialog box you
may block a signal for a particular interval, define the location and appearance
each interval button, map a button response to a keyboard key, or set up a
parallel interface such as an LED.

Subject Opens the Subject dialog box, from which you may enter the subject
name and optional comments.

Feedback Opens the Feedback dialog box, from which you may defined
feedback parameters.

The Experiment Menu

Running Mode and Configure Mode

| Eaperiment [

Bun
Pausze
Abort

LCalibrate

The Experiment Menu allows you to run, pause, or abort an experiment.
Run Runs the current experiment.

Pause Pauses the current experiment.

Abort Aborts the current experiment.

Calibrate Opens the Calibration dialog box, from which you may specify a
calibration signal.

PsychoSig User's Guide
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the PsychoSig Main Windows

For details, see
“Using PsychoSig Help”
later in this chapter

PsychoSig User's Guide

The View Menu

Running Mode Configure Mode
v Toolbar Bun Track
v Status Bar v Toolbar Text
Split v Status Bar

Split

From the View menu, you may configure the appearance of PsychoSig.
Output Allows you to specify the content of the output window.

Run Track Displays a running graph of the variable value during an
experiment.

Text Displays experiment data in text format.
Toolbar Displays/hides the Toolbar.
Status Bar Displays/hides the Status Bar.

Split Places the mouse pointer in a position that allows you to easily resize the
output and experiment windows.

The Help Menu

Running Mode and Configure Mode

Help Topics

About PsychoSig...

From the Help Menu, you can access on-line help and the RsguhoSig
dialog box.

Help Topics Displays a list of help topics available

About PsychoSig Displays version and copyright information
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The Toolbar

On the PsychoSig Toolbar, you can find quick point-and-click access to the most
common PsychoSig commands.

Run Mode Configure Mode

= x]=[@ (@2 [DO]=[d] e x]®] =] [x]Z]@] [E] 72

Click To

New Clear the Output Window and reset PsychoSig to
its default settings.

Open Open an existing PsychoSig file

Save Save the PsychoSig file

Setup Signal Select and load tha file

[5]

Setup Variable Define variable parameters

X
Setup Define experiment parameters
Experiment
Setup Define interval parameters
Intervals

Setup Subject  Enter subject information

@] [a] B [¢]

Setup Define feedback
Feedback
" Experiment Run an experiment
Run
I I Experiment Pause an experiment
Pause
. Experiment Abort an experiment
Abort
File Print Print the currently displayed result data

Help About Access the About PsychoSig dialog box

Help Invoke context help

| [] @

PsychoSig User's Guide
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Using PsychoSig Help

PsychoSig User's Guide

The PsychoSig help files provide context-sensitive help, usage tips, and
troubleshooting information that may not be in this manual. Understanding how
to use the help system will help you to best tailor PsychoSig to your research.

Context-Sensitive Help

When you invoke the help system, information is displayed that corresponds to
the function you are presently performing.

To invoke context-sensitive help

» Press1 from within any dialog or while any menu item is selected.
or

1. Click the context help icon

2. Select a menu item or click the mouse on an object on the screen.

Help information will be displayed about the selected item.

To get information about how to use Windows Help, pFedsfom within any
help topic.

The On-line Troubleshooting Guide

The PsychoSig help system includes a troubleshooting guide that answers the
most commonly asked questions about the program. Consult this section if you
have questions.

To use the On-line Troubleshooting Guide
1. Select Help Topics from the Help menu
2. Double-click the “Troubleshooting Guide” topic.

The PsychoSig Troubleshooting Guide will appear. Select the troubleshooting
topic of interest to you.



Chapter 3 Designing Experiments

Those users with access to the configure mode password may log in to
configuration mode. While in configuration mode, the user may design
experiments. A step-by-step description of the experiment design process
appears below.

Build and save the SigGen stimulus signal.

Run PsychoSig in configure mode.

Assign the SigGen signal.

Define the experimental variable (dynamic variable) parameters.
Specify experiment parameters.

Customize each interval.

Define feedback.

Enter subject information.

© © N o g kM NP

Save the PsychoSig file.

Building the SigGen Signal

New Users —

Read this section before
you design your SigGen
signal.

Prior to designing your experiment in PsychoSig, you must build a stimulus
signal in SigGen. SigGen is a very powerful package that allows users to build
many types of complex stimuli.

For the most part, the process of designing a SigGen stimulus for use with
PsychoSig follows the instructions presented inSiggen User’'s Guide.
Differences particular to PsychoSig are noted with an exclamation mark in the
margin.

The instructions below will take you through the basic steps of signal design in
SigGen. For more detailed instructions, seeSig&en User’'s Guide

Defining the Experimental Stimulus

The basic steps necessary to design a SigGen signal for use with PsychoSig are
presented below.

1. Run SigGen

2. Define signal parameters.

3. Define experimental and condition variables.
4. Define segment parameters.
5

Save the SigGen file.
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Defining the Experimental Variable

The experimental variable is the signal parameter that will vary across
experimental trials. Because PsychoSig varies the experimental variable
according to the subject’s responses, it must be defined in SigGelyaarmic
variable

Define the experimental variable as a dynamic variable in the Signal Variable

dialog box.
— General —WValue Limits
Mame Units Default/Start
[Level | B | step Sice f]
|h:;it:::i.: ] | EditList Minimum
Prompt/Comment Maximum
|Unknuwn Prompt Mo. of Steps
File Hame Find File__.
— SG1 Modifiers
Oftset [0 |
— Combination Yanable Repeat Factor D
Variable: |Hune E“ Skip Factor D
Operation: Yalue:
| =V + Vcomb E“ ||]_ | — Termination Control
@ Nomal/Mone
Cancel O Boundary Control
Preview OLoop
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To define the experimental variable
1. Enter the name of the variable in the Name field.
2. Enter the units of the variable in the Units field.
3. Choose Dynamic from the Method list box.
4. Enter the initial value for the variable in the Default/Start field.
This will be the variable value for the first trial of every condition.
5. Skip step size.
You will define initial and final step sizes in PsychoSig.
6. Enter the minimum allowable variable value in the Minimum field.
7. Enter the maximum allowable variable value in the Maximum field.
8. Click OK.

Note: PsychoSig requires that one and only one dynamic variable be defined in
the SigGen files it uses.

Defining a Condition Variable

A conditionis You may want to conduct your PsychoSig experiment in multiple conditions.
analogous to a SigGen |t is possible to set up multiple conditions through use of one or more
Index. additional SigGen variables.

Condition variables may be defined using any SigGen method but dynamic.
SigGen and PsychoSig both understand that when a non-dynamic variable and a
dynamic variable are defined, the non-dynamic variable varies systematically
across conditions while the dynamic variable varies based on the subject’s
response across trials.
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Condition variables are defined in the Signal Variable dialog box. The
following is an example of defining a single condition variable.

Signal ¥Yariable E

r General rVYalue Limits
Name Units Default/Start
|Frequency | |Hz |
Step Size
Method ..
| Linear Step E| Edit List Minimum
M aximum
Prompt/Comment
|Unknuwn Prompt Mo. of Steps D
File Hame Find File. .
r 5G1 Modifiers
offset 0|
— Combination ¥anable Repeat Factor I:l
Variable: |Nune IE“ Skip Factor |:|
Operation: Yalue:
-¥ + Ycomb E“ ||]_ | — Termination Control
{OJMormal/Mone
Cancel () Boundary Control
Preview
0K O Loop

To define a condition variable

1. Enter the name of the variable in the Name field.

2. Enter the units of the variable in the Units field.
/ 3. Choose any method but Dynamic from the Method list box.

4. Enter the initial value for the variable in the Default/Start field.

This will be the variable value for the first condition.

5. Enter the step size, if appropriate for the chosen method.
6. Enter the minimum allowable variable value in the Minimum field.
7. Enter the maximum allowable variable value in the Maximum field.
8. Click ® Boundary Control.

This will cause the experiment to terminate when the number of conditions
defined by this variable have been presented.

Click OK.

©
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Note: PsychoSig expects that at least one condition variable will be defined
with Boundary Control so that the experiment has 100 or fewer conditions. If
you do not need any condition variables for your experiment, create a dummy
variable that uses boundary control to limit the number of conditions to 100.

To preview conditions

» Click the Preview Variables button located on the SigGen main window.

Yariable Preview E

SGI1 [Frequency] lewel ... . .
1 3000 &0
2 2500 80
3 2000 80
4 1500 80
5 1000 80
6 h00 80
Term. =a00 80
| AR | | ik | [ Show Combined Values | Done 1

In the above exampl&requencyhas been defined as a Linear Step variable
while Levelhas been defined as a dynamic variable. SigGen has constructed 6
conditions, or SigGen Indices (SGIs) based on the definition of the variable
Frequency. For each condition (SGI), the dynamic variaélelis initially set

to 80 dB and varies according to user response.

Defining Multiple Condition Variables

You may want to vary more than one parameter across conditions. To do so,
you must control each parameter with a separate condition variable. In order to
present all possible variations, multiple condition variables must be nested.

In the example that follows, two condition variables have been cré&xaéd],

the onset of a tone following a masker, &ndgquencythe frequency of the tone.
The variable=requencyis nested within the variabl@eltaT. Notice how the

value ofDeltaT remains constant for the first three conditions (SGIs) while the
value ofFrequencyis allowed to vary from 500 to 1000 to 3000. The value of
DeltaT changes at condition (SGI) 4 and remains constant for three conditions
while Frequencyagain varies from 500 to 1000 to 3000. FindDgjtaT takes

the value of 300 whil&requencyaries one last time from 500 to 1000 to 3000.
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S5Gl [DeltaT] Freq. Level ... ..

1 330 500 80
2 330 1000 80
3 330 3000 80
4 30 500 80
5 30 1000 80
6 30 3000 80
7 300 500 80
] 300 1000 80
9 300 3000 80

Term. =300 3000 80

| e | | M | [ Show Combined Yalues | Done I

PsychoSig User's Guide

Loop. In this example, the variabfgequencyhas been defined with a
Termination Control of Loop. This causes SigGen to loop through all possible
values until the final boundary conditions have been met. When condition
variables are nested, all condition variables except the highest level variable
must be defined with a Termination Control of Loop.

Repeat Factor In the example, the varialileltaT has been defined with a
Repeat Factor of 3. This causes SigGen to hold this value constant for three
conditions while allowing the variablrequencyto cycle through its three

values. All nested condition variables except the lowest level variable must have
a repeat factor that specifies the number of conditions for which the variable
should be held constant.

Defining the Standard Stimulus

The standard stimulus holds the experimental variable constant throughout the
experiment. In many cases, an element of the experiment is eliminated by setting
the experimental variable to zero.

The value of the experimental variable during standard stimulus presentation is
set in PsychoSig. The manner in which this is accomplished is discussed in a
later section, “Defining the Experimental Variable.”
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Designing Multi-channel Experiments

PsychoSig allows you to design experiments that play stimuli to one or two
channels. One-channel experiments are referredntmasticor diotic; two-
channel experiments adéchotic

Two-channel (dichotic) experiments are reported as “Binaural” in the PsychoSig
output file.

Monotic: Stimulus Played to One Ear

Monotic experiments are the simplest and most common experiments. Define
the SigGen stimulus and utilize it in the PsychoSig. Connect the output signal to
either channel of the headphone buffer.

Diotic: One Stimulus Played to Both Ears

Diotic experiments are identical to monotic experiments except that the signal is
played to both ears. Connect the signal to both input channels of the headphone
buffer.

Dichotic: Different Stimuli to Each Ear

Dichotic experiments present different stimuli to each ear. PsychoSig uses
separate SigGen files to define the stimuli. The two files must have the exact
same variable definitions, however, as the second stimulus uses variables defined
in the first.

Note: Though allowable, it is recommended that calibration valoebe
different between the SigGen files used in a dichotic experiment. The following
procedure is recommended for creating dichotic experiments.

To prepare a dichotic experiment
1. Create the SigGen stimulus for the first channel.

Include calibration information and define any variables that may be used in
the second file, even if they are not used by the first.

2. Save the file.
Use Save As to save the file under a new name.

4. Change the segment parameters to create the second stimulus.
Do not alter the signal parameters or the variables.

5. Save the second stimulus.

You can then use these files as the Channel 1 and Channel 2 signals in
PsychoSig.

Note: The A/D channel assignments made in the SigGen Signal Setup dialog
box are ignored by PsychoSig. PsychoSig uses channels 1 and 2 of your A/D as
shown in the Load Signal Files dialog box of the next section.
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Running PsychoSig in Configure Mode

In order to set up an experiment, you must run PsychoSig in configure mode.

To run PsychoSig in configure mode
1. Run PsychoSig

2. Click ® Configure an Experiment.

3. Enter the configure mode password.

4. Click OK.

The PsychoSig Configure Experiment window will appear. You now will have
access to all PsychoSig experiment design functions.

Assigning a SigGen Signal
Your first step in PsychoSig is a simple one. You must assign one or two
SigGen signals as your stimulus.
To assign a SigGen signal
1. Choose Signal from the Setup menu.

2. You will see the Load Signal Files dialog box.

Load Signal Files E3

~ Chaninel 1

SigGen File: | | |Brnwse|
~ Channel 2

O Enable

SiglGen Fie: | | [Browsce|

Cancel

3. Enter the file name of the SigGen file to play out of Channel 1.

If you click the Browse button, you will see the Open dialog box. Select a
SigGen file as you do with all other Windows applications.
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Lockin |8 Siggen

Freq_gap.sig
Harm. sig

Hrm_noiz.sig
_'I'ime_gq!:l.sig

File name: ITDne.sig I I Open I

Files of ype:  [Siggen Files [+ sig) -]

Define the experimental variable as described in the next section.

See the earlier section, 4. If you are creating a dichotic experiment, click the Channel 2 enable box
Designing Multi- and enter the SigGen file name to play out the second channel.

channel Experiments
for details on how to
create the second
SigGen file.

You can select the second file name by clicking on the Browse button.
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Defining the Experimental Variable

Experimental variable parameters are defined from the Dynamic Variable
Setting dialog box. This dialog box automatically appears when a new SigGen
signal file is assigned to Channel 1 of the experiment. This dialog box can also
be accessed manually.

To manually access the Dynamic Variable Settings dialog box

» Choose Variable from the Setup menu.

Dynamic Variable Settings

Warable:  Lewel

- Signal Parameters
=" alues

Imitial Walue: |BO

May Value: [100
MinValue: |0

- Tracking

e T

Initial Step Size:
Final Step Size:

Incremant: Imcorrect
Decrement: Corect
|Jze Final Step: Rewverzals
Stop: Trials

ar Rewersalz

- Standard Parameters

W ariable W alue: D

General Parameters

Variable. This field displays the name of the dynamic variable as defined in the
SigGen file.

Units. This field displays the units associated with the dynamic variable as
defined in the SigGen file.

Experimental Signal Parameters

The parameters defined in the Signal Parameters group box determine the
starting value and allowable range of variation for the experimental variable.
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Variable Values

Parameters that determine the value of the experimental variable may be found
in the Values group box.

Initial Value . This field specifies the initial value of the experimental variable.
The value specified in this field will be assigned to the experimental variable for
trial 1 of each experimental condition. The Initial Value field defaults to the
SigGen Default/Start variable value. You may override the default value.

Max Value. This field defines the maximum possible value of the experimental
variable. The Max Value field defaults to the SigGen Maximum variable value.
You may override the default value.

Min Value. The Min Value field specifies the minimum possible value of the
experimental variable. The Min Value field defaults to the SigGen Minimum
variable value. You may override the default value.

Note: PsychoSig keeps the value of the experimental variable within the range
specified by Min Value and Max Value.

Tracking Parameters

In the Tracking group box, you will find parameters that define how PsychoSig
will track the experimental variable.

Method

Additive

Mulkiplicative

Additive Tracking. Choosing this option causes the experimental
variable to be incremented or decremented through addition or
subtraction of the current step size, respectively. Such tracking results
in linear changes in experimental variable values.

Multiplicative Tracking . Choosing this option causes the
experimental variable to be increased or decreased through
multiplication or division by the current step size, respectively,
resulting in exponential changes in experimental variable values.

Initial Step Size This field defines the change in the experimental variable at
the beginning of each trial.

Final Step Size This field defines the change in experimental variable value
across trials once the Use Final Step humber of reversals has occurred.

Increment. The Increment field defines the number of incorrect responses
required for an increase (addition or multiplication) by the current step size of
the experimental variable.

Decrement This field specifies the number of correct responses required for a
decrease (subtraction or division) by the current step size of the experimental
variable.

Use Final Step This field defines the number of reversals required to change
the step size from the initial step size to the final step size.
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Stop. The two Stop fields define parameters used to specify when to end an
experimental condition.

Trials. The experimental condition will end when the number of trials
executed equals this value.

Reversals The experimental condition will end when the number of
reversals equals this value.

Standard Signal Parameters

Wariable Yalue: I:l

Variable Value. The experimental variable will be set to this value during
intervals presenting a standard signal.

|'Stanu:|aru:| Parameters

Defining Experiment Parameters

PsychoSig User's Guide

Once you have assigned a SigGen stimulus signal and specified dynamic
variable parameters, you may define experimental parameters. Experimental
parameters are defined from the General Experiment Parameters dialog box.

To access the General Experiment Parameters dialog box

» Choose Experiment from the Setup menu.

General Expenment Parameters E

Murnber of |ntervalz:

~ Candition Cantrol - Sarmple Trial
@® Automatic O Present S ample Trial
I I
g u:;u: ecified - Hethod
P (& Play Once
Select Conditions O Play Continuous
Tiri - Conditionz
= Timing ) .
Inter-Stimuluz [nkerval: 500 mzec O Before First Condiion
(=} Before All Conditions
Inter-Trial Interval: 500 mzec O User Specified
Inter-Candition Interval: A00 | mzec S alect Conditions
Stimuluz Indicatar Duration: |500 ] meec

- Fesults

Resultz File:  |CATDTASigGenhPzySigiFilesesults. dat | | Browse |
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General Parameters

Number of Intervals. This field defines the number of intervals per trial. You
may have from two to six intervals.

Condition Control

Conditions in PsychoSig correspond to SGls in SigGen. Typically, an
experimental variable will be manipulated in multiple conditions. The manner in
which conditions are presented during an experiment is controlled from the
Condition Control group box located in the General Experiment Parameters
dialog box.

Automatic. Choosing Automatic causes the experiment to automatically
execute all conditions, or SGIs, consecutively at experiment runtime. This is the
default experiment execution parameter.

Manual. Choosing this parameter allows the researcher to manually select
which conditions (SGIs) will be presented. Such selection is made at experiment
runtime.

User Specified By choosing this option, the researcher may select one or more
conditions (SGIs) from the list of all conditions. Only the selected conditions
will be presented at experiment runtime.
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User Specified Condition Control

~ Condition Cantrol
O Automatic

Select Condtions

You may select specific conditions (SGIs) for each experiment. Conditions are
selected from the Manually Specify Conditions dialog box.

To access the Manually Specify Conditions dialog box
1. Select® User Specified Condition Control.
2. Click the Select Conditions button.

M anually 5pecify Conditions [ ]

SGI Duration Lewel L

7 500,00 E0.00 000 ] .00
2 475.00 50,00 0.00 000 0.00
3 450.00 £0.00 000 0.00 0.00
4 425,00 5000 000 0.00 0.00
5 400.00 5000 000 0.00 0.00
5 375.00 50,00 0.00 000 0.00
7 350.00 £0.00 000 0.00 0.00
g 225,00 5000 000 0.00 0.00
g 300.00 50,00 0.00 000 0.00
10 275.00 £0.00 0.00 000 0.00
11 250.00 £0.00 000 0.00 0.00
12 225,00 5000 000 0.00 0.00
13 200.00 50,00 0.00 000 0.00
14 175.00 £0.00 000 0.00 0.00
15 150.00 £0.00 000 0.00 0.00
15 125.00 5000 000 0.00 0.00 Do Even
17 100,00 50,00 0.00 000 0.00
Do Odd

Fiepeat Factar:

PsychoSig User's Guide

Repeat Factor. PsychoSig executes all selected conditions in ascending
numerical order. This sequence is performed the number of times specified in
the Repeat Factor field.

To select a single condition

» Click the desired condition.

To select multiple conditions
» Citrl-Click the desired conditions.
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To select multiple contiguous conditions

» Drag the mouse over the desired conditions while depressing the left mouse
button.

or
1. Click the first condition.
2. Shift-Click the last condition.

To select even-numbered conditions
» Click Do Even.

To select odd-numbered conditions
» Click Do Odd.

To de-select all conditions
» Click Clear.

To clear individual conditions
» Citrl-Click the desired conditions.

To accept conditions and exit

» Click OK.

Timing

= Timing
Inter-Stimulus |nterval 500 mzec
[rter-Trial Interval: mIec
Inter-Condition [Rterval; 001 mzec
Stimuluz Indicator Duration: 900 ] meec

Timing parameters are used to specify the timing of events during the
experiment. Timing parameters are located in the Timing group box.

Inter-Stimulus Interval . This field defines the time in milliseconds between
stimulus presentations.

Inter-Trial Interval . This field defines the time in milliseconds between trials.

Inter-Condition Interval . This field specifies in milliseconds the duration
between successive conditions (SGls).

Stimulus Indicator Duration. This field defines in milliseconds the duration
of an optional external stimulus indicator.
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Sample Trial

= Sample Trial

[ Frezent Sample Trial

= hethod
& Play Once

O Play Continuous

= Conditions
{2 Eefore First Condition

O Before Al Conditions
& User 5pecified

Select Conditions

You may present the subject with a sample trial prior to the beginning of data
collection. Sample trial parameters are specified in the Sample Trial group box.

Present Sample Trial Checking this box enables the presentation of a sample
trial.

Method

A sample trial is simply a preview of the first trial. The sample trial may be
played once or played continuously. During presentation of sample trial, the
background of the Experiment window is orange. The subject’s response to the
sample trial is not recorded in the output file.

Play Once Choosing this option causes a single sample trial to be played.

Play Continuously. Choosing this option causes the sample trial to play
continuously until the subject responds.

Conditions

Before First Condition. Choosing this parameter causes the sample trial to
occur only before the first experimental condition (SGI).

Before All Conditions. Choosing this parameter causes the sample trial to
occur before each experimental condition (SGI).

User Specified Choosing this parameter allows the user to specify which
conditions the preview trial will precede.
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See the previous
section, Condition
Control , for details on
selecting conditions for
which to present sample
trials.

The format of the data
file is described in
Chapter 5 —Data
Collection. A sample
.dat file is also shown.

User Specified Condition Control

You may preview a trial before specific conditions (SGIs). Conditions are
selected from the Manually Specify Conditions dialog box.

To access the Manually Specify Conditions dialog box

1. Select® User Specified Conditions.

2. Click the Select Conditions button.

You will see the Condition Control dialog.

Note: The Repeat Factor field in the Manually Specify Conditions dialog has

no significance for sample trial presentation.

Results

Resultz
[ Fesults File: |E:'\TDT'xSigGen'xF's_l,lSig'xFiIes'xHesults.dat | I Browse I

Results from PsychoSig experiments are automatically written to a PsychoSig
data file in text format. The default extension used by PsychoSig data files is

.dat.

If the file specified already exists, data is appended to the end of that file.
Otherwise, a new file is created with the specified name.

Note: You must specify a results file prior to running an experiment.

To specify a PsychoSig data file
» Enter the file name in the Results File field,
or
1. Click Browse.
2. Enter or choose the desired path and file name.
3. Click OK.
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Specifying Intervals

Interval parameters may be defined from the Interval Properties dialog box.

To access the Interval Properties dialog box

» Choose Interval from the Setup menu.

Previously, you defined the number of intervals in the General Experiment
Parameters dialog box. The interval properties dialog box consists of index
cards that correspond to each defined interval.

To change intervals

Click the file tab label with the desired interval button number.

Interval Properties E3

Interval 1 I [rteral 2|

= Stimulus
O standard Only

= Button Appearance

:=<: «f; Width: Height:

= | pper Left Corner |- Size

- Shyle
e
) Bitmap | ”En:uwsel

- F.eyboard Interface
Map to Key:

= Parallel Interface

Output Bit O Use Megative Logic

Input Bit: I1ze Megative Logic

Cancel I | Help

Stimulus

M Standard Signal Only. Checking this box causes the standard stimulus only
to be played during this interval.

This feature is useful if you wish to have an interval (button) that is always
“wrong.” Such a button might be labeled “Can't tell” or “Don’t know” as
described below.
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Button Appearance

The Experiment Window is divided into 100 x-axis units and 100 y-axis units.
Button locations and sizes are defined in terms of x-axis and y-axis coordinates.
Values from 0 to 100 are valid.

Upper Left Corner

X. This value defines the x-axis coordinate of the interval button’s upper left
corner. The x-axis coordinate is defined in terms of the number of units to the
right of the Experiment Window left boundary.

Y. This value defines the y-axis coordinate of the interval button’s upper left
corner. The y-axis coordinate is defined in terms of the number of units below
the Experiment Window top boundary.

Size
Width. This value defines the width of the interval button.

Height. This value defines the height of the interval button.

Style

® Text. When this button is chosen, text entered in the Text field will appear
on the interval button.

@ Bitmap. When this button is chosen, the bitmap entered in the Bitmap field
will appear on the interval button. You may type in the bitmap file name or click
Browse and select the file name from the directory listing. Only .BMP files can
be displayed.

Keyboard Interface

PsychoSig allows users to respond via a keyboard interface. Users may respond
with any numeric key (0-9).

Map to Key. The value in this field corresponds to a numeric key (0-9) which
users may press to indicate a response.

Parallel Interface
PsychoSig supports the use of a parallel interface through TDT’s PI2.

Output Bit. This field specifies the output bit (1-8) used to communicate to an
external device. To use negative logic, chEtklse Negative Logic. Standard
TDT response boxes have positive logic outputs.

Input Bit. This field specifies the input bit (1-8) used to receive data from an
external device. To use negative logic, chEtkse Negative Logic. Standard
TDT response boxes have negative logic inputs.
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Specifying Feedback

PsychoSig User's Guide

You may wish to provide feedback to subjects for correct or incorrect responses.
Feedback may be specified from the Feedback dialog box.

To access the Feedback dialog box

» Choose Feedback from the Setup menu.

Feedback [ |

Feedback Duration: |500 | meec

Caricel

[ Show a Bitmap

- Ipper Left Corner Size
Esl LU S 10—‘ [Width; 20 Height: |20

= Bitrap Files
Coarrect: Browse
[mzarrect: Browse

O Flay a Sound

~ Sound Files

Correct: Browse

[ncomect: Browse
[ Light an Led

- P2 Bits
Correct; O Usze Negative Logic

[ncarect: O Use Neqative Logic

PsychoSig provides for three types of feedback:
B Show a bitmap

B Play a sound

B Lightan LED

You may implement any combination of these three types of feedback or choose
no feedback at all.
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General Parameters

Feedback Duration This field defines the duration of feedback in
milliseconds.

Show a Bitmap

PsychoSig allows you to allocate an area of the screen for visual presentation of
feedback. Visual feedback is created by assigning a bitmagofitpfile) to

this screen area. You may assign sepabatgfiles for correct and incorrect
responses.

The Experiment Window is divided into 100 x-axis and 100 y-axis coordinates.
The feedback screen area is specified using these coordinates.

M Show a Bitmap Checking this field causes the bitmaps defined in the Correct
and Incorrect fields to be displayed in the feedback screen area when subjects
respond correctly and incorrectly, respectively. You must spdwiipfiles for

both correct and incorrect responses if this box is checked.

Upper Left Corner

X. This field specifies the x-axis coordinate of the feedback area’s upper left
corner. The x-axis coordinate is defined in terms of number of units to the right
of the Experiment Window left boundary.

Y. This field specifies the y-axis coordinate of the feedback area’s upper left
corner. The y-axis coordinate is defined in terms of number of units below the
Experiment Window upper boundary.

Size
Width. This field defines the width of the feedback area.
Height. This field defines the height of the feedback area.

Bitmap Files

If you have checkedq Show a Bitmap, you must entémpfiles for both
correct and incorrect subject responses.

Correct. Define abmpfile as feedback for correct responses by typing in the
file name or clicking Browse and selecting from the directory listing.

Incorrect. Define abmpfile as feedback for incorrect responses by typing in
the file name or clicking Browse and selecting from the directory listing.
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You can create a 16-bit
binary file with the
Save Wave command
on the SigGen File
menu.

Play a Sound

O Play a Sound
Sound Files
Correct: | ”En:nwsel
Incarrect: | ”Bru:uwsel

PsychoSig allows you to assign sound files for use as feedback. Sound files
must be in 16-bit binary format (.16). PsychoSig will not play wave fileay

files) correctly.

Note: The sampling rate of the binary sound file must be the same as the
sampling rate defined when building the stimulus signal in SigGen. PsychoSig
will automatically play all signals at the SigGen sampling rate.

M Play a Sound Checking this field causes the binary sound files defined in
the Correct and Incorrect fields to be played as feedback when subject
responds correctly and incorrectly, respectively. You must specify binary
sound files for both correct and incorrect responses if this box is checked.

Sound Files

If you have checked Play a Sound, you must enter sound files for both correct
and incorrect subject responses.

Correct. Define a sound file as feedback for correct responses by typing in the
file name or clicking Browse and selecting from the directory listing.

Incorrect. Define a sound file as feedback for incorrect responses by typing in
the file name or clicking Browse and selecting from the directory listing.

Light an LED

[ Light an Led

FIZ Bits
Correct: O Usze Megative Logic

Incomect: O Use Megative Logic

You may wish to light an external LED. Such a device may be controlled
through use of TDT's parallel interface module, the PI12.

P12 Bits
You must define which bit (1-8) will be used to control feedback via an LED.

Correct. Defines the bit (1-8) used to signal a correct response. To use
negative logic, checkl Use Negative Logic.

Incorrect. Defines the bit (1-8) used to signal an incorrect response. To use
negative logic, checkd Use Negative Logic.
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Specifying Subject Information

Subject information is defined through the Subject dialog box.

To access the Subject dialog box

» Choose Subject from the Setup menu.

M armne: |

Comments:

Name Enter the subject name or other identifying information in this field.
You will not be allowed to run an experiment until an entry in this field is made.

Comments You may enter any optional comments in this field.

Saving the PsychoSig File

Once all PsychoSig parameters have been entered, you must save the PsychoSig
file.

PsychoSig files use the default extensipa, You should use this extension
when saving all PsychoSig files.

To save the PsychoSig file

» Choose Save or Save As... from the File menu.
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Chapter 4 Running Experiments

Once you have designed the PsychoSig experiment and entered subject
information you are ready to calibrate your system and run the experiment.

Choosing an Experiment Mode

Experiments may be run from either PsychoSig modes:
B Run mode
B Configure mode

As mentioned in a previous section, users may not configure experiments when
in run mode. Users may, however, run experiments from both run mode and
configure mode.

The process of running an experiment is identical in both run mode and
configure mode. The only difference lies in the screen display.

Run Mode

Title Bar Menu Bar Tool Bar

7 Untitled - Run Experiment
Eile

Stimuli Experiment Yiew Help

F2]@] [Z] 2]\

Interval 1 Interval 2

\ / Experiment Window

Interval Buttons

For Help, press F1 l:“:l ]

Run mode is designed for subjects. The screen consists of the Experiment
Window, only. There is no Output Window. Interval buttons are displayed in
the Experiment Window. The subject may respond to stimuli by selecting an
interval button. No data are displayed during the experiment.
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To run an experiment in run mode
1. Run PsychoSig.

You will see the Startup dialog box.

PsychoSig Startup El

............................................. DK

{2 Configure an Experiment

Pazavaond: |

2. Click ® Run an Experiment.
3. Click OK.

Configure Mode

Title Bar Menu Bar Tool Bar

r;l._UntilIed - Configure Experiment

File Setup Experiment Yiew Help

Ol=d] el x[w2]=] x[2]e] @[eDe]| |

Interval 1 Interval 2

Interval Buttons

Output Window Experiment Window

For Help, press F1 |:| -
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Configure mode is designed for experimenters. Configure mode includes the
Experiment Window and the Output Window. Interval buttons are displayed in
the Experiment Window. The subject may respond to stimuli by selecting an
interval button. As the subject responds, the data may be plotted in the Output
Window (see below).

To run an experiment in configure mode
1. Run PsychoSig.

2. You will see the Startup dialog box.

PzypchoSig Startup E3

2 Run an Experiment

@ Configure an Experiment

Pazszword: ||

3. Click ® Configure an Experiment.
Enter the configure mode password.
5. Click OK.

Running

To run a PsychoSig experiment, you must do the following three things:
B Open the PsychoSig file
B Calibrate the system

B Run the experiment
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Running

Opening the PsychoSig File

To open the PsychoSig file

1. Choose Open from the File menu.

2. Choose the desired PsychoSig file from the directory listing.
3. Click OK.

Calibrate the System

PsychoSig provides a means for calibrating your system using an external
attenuator. From the Calibration dialog box, you may generate a calibration
tone. You may also play the experimental stimulus and the standard stimulus.

To access the Calibration dialog box

» Choose Calibrate from the Experiment menu.

Calibration [ |

~ Tone Calibration

Frequency: 1000 -
_I:ancel
Lewvel 100 dB SPL
05 valts
I Play I | Stop I
- Siggen File

10000 dB SPL = 0.50wols = 0.35 volts s

|F'Ia}I Signall |F'Ia}I Standardl | Stop |

During SigGen signal design, you are asked to specify a voltage-to-dB
relationship. This relationship is saved with your SigGen file. The PsychoSig
Calibration dialog box reads the calibration information from the SigGen file
specified for Channel 1 and uses it during calibration.

To calibrate your system using a tone
1. Setyour attenuator to 0 dB attenuation.

2. Enter the desired frequency.

3. Click Play.

4. Measure the output sound pressure level.
5

Adjust the attenuator until the output sound pressure level equals that
displayed in the Level field.

6. Click Stop.
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See the Chapter 3
section, Condition
Control for details

To change the output level of the tone
1. Enter a value in either the dB SPL field or the volts field.
2. Press Tab.

The value in the other Level field will be modified based on the volts-to-dB
relationship defined in the Channel 1 calibration field.

To calibrate your system using the SigGen stimulus
1. Setyour attenuator to 0 dB attenuation.

2. Click Play Signal for the experimental signal or Play Standard for the
standard signal.

The signal for the first condition (SGI=1) will be played continuously.
Measure the output sound pressure level.

4. Adjust the external attenuator until the output sound pressure level equals
that displayed in the “SigGen file” box.

Click Stop.

o

Run the Experiment

Once you have configured your equipment and prepared the subject, you are
ready to run the experiment.

Run Modes

During experiment setup, you will have chosen one of three running modes:

B Automatic

®  Manual

B User Specified

PsychoSig will present conditions (SGIs) based on the mode you have chosen.

Automatic. If this mode has been chosen, PsychoSig will present all conditions
(SGls).

Manual. If this mode has been chosen, PsychoSig will present only the
condition (SGI) specified in the SGI field.

User Specified If this mode has been chosen, PsychoSig will present only the
conditions (SGIs) selected in the Condition Control dialog of Setup Experiment.

Running

To run the experiment

1. If running in manual mode, set the SGI field to the desired condition (SGI).
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2. Choose Run from the Experiment menu.

Note: While running an experiment, PsychoSig’'s Experiment Window appears
green. The Experiment Window appears blue when idle.

Ready to Begin a Condition (SGI)

Prior to the presentation of each condition (SGI), all interval buttons repeatedly
depress and release in synchrony. This is a signal to the subject to begin the
condition when ready.

To begin a condition
» Click any interval button.

PsychoSig will begin presenting trials.

Presenting Trials

The experimental stimulus and all standard stimuli are each randomly assigned
to an interval and presented to the subject. As a stimulus is played, its interval
button depresses to provide the subject with a visual cue.

The experimental variable will be presented at its defined start value during the
first trial of each condition. This variable will vary across trials based on the
defined variable parameters and the subject’s response.

Responding to Trials

Subjects may respond to a trial in one of three ways:
B By clicking the desired interval button.

B By depressing a keyboard key.

B By interacting with a parallel interface.

Condition Completion

The condition is completed when the following criteria are met:

B The maximum number of trials has been presented.

B The maximum number of reversals has occurred.

The first condition will be presented until completed. Upon completion, both

interval buttons will repeatedly depress and release in synchrony, indicating to
the subject that the next condition is about to begin.

To begin subsequent conditions
» Have the subject click either interval button.

PsychoSig will continue with the next condition.
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Termination of the Experiment

PsychoSig will continue the experiment until all conditions have been
completed. However, the experiment may be terminated or paused at any time.

To manually terminate the experiment

» Choose Abort from the Experiment menu.

To pause the experiment

» Choose Pause from the Experiment menu.
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Data Collection

PsychoSig stores summary data into the user-specified dataditéile). The
data is saved in text format.

The Results File

When each condition (SGI) terminates, either normally or by aborting, the
following information is written to the data file:

Date and time the condition ended
Termination status (ABORTED, COMPLETED)
SigGen file name(s)

Condition (SGI) number

Presentation mode (Monaural, Binaural)

Single-channel experiments are listed as Monaural, while two-channel
experiments are shown as Binaural. PsychoSig makes this assumption, as it
has no way of knowing if a single-channel experiment has been presented
binaurally (a diotic presentation).

Value of SigGen variables for this condition

Starting value and range of the dynamic variable
Tracking method and step sizes

Number of trials run and reversals that occurred

The tracking algorithm (number up/down)

Subject name with comments

Mean, Standard Deviation, and Standard Error

Percent correct and incorrect responses for each interval
Initial value of the experimental variable

Value of the experimental variable at each reversal (those that occurred
under the initial step size are bracketed[ ])

The statistics are calculated on the last even number of final-step-size reversals.
If the statistics cannot be validly computed, values of “999.90” are displayed.
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A sample .dat file appears below.

Wednesday, November 20, 1996. 13:52:32
Status: COMPLETED

SigGen File:
C:A\TDT\SigGen\PsySig\Files\left.sig
SGl=1

Subject ID:

Comments:

Presentation mode: Binaural
SigGen Variables:

Band 1 level : -50.00 dB (Range -100--100, Default -50.00, Step  0.00)
Bandl Low : 0.00 Hz (Range 0--20000, Default 0.00, Step 0.00)
BandlHigh : 900.00 Hz (Range 0--20000, Default 900.00, Step  0.00)
Tone 1 : 1000.00 Hz (Range 0--20000, Default 1000.00, Step  0.00)
Tone 2 : 1300.00 Hz (Range 0--20000, Default 1300.00, Step  0.00)
Band2 Low : 1400.00 Hz (Range 0--20000, Default 1400.00, Step  0.00)
Band2 High : 11400.00 Hz (Range 0--20000, Default 11400.00, Step  0.00)
Band 2 Level : -10.00 dB (Range 0--20000, Default -10.00, Step 0.00)
Counter : 1.00 (Range 15.00- 1.00, Default 1.00, Step 1.00)

Dynamic Variable:
Tone level (dB) Start Value = -5.00 Max = 10.00 Min =-100.00. Standard Value = -100.00.
Tracking Configuration:
Initial Step Size = 5.00 Final Step Size = 2.00 (after = 3 reversals).
44 of a maximum 60 trials were run. 12 of a maximum 12 reversals were recorded.
The tracking algorithm was 1 up, 2 down, with additive adaptation.
Mean: -44.50 Std. Dev.: 3.66 Std. Err.: 1.30
Pct. Correct Interval 1: 96.00
Pct. Correct Interval 2: 52.63
Starting Value: -5.00
Reversals: [ -50.00 -45.00 -50.00 -48.00 ] -50.00 -46.00 -48.00 -44.00 -46.00 -40.00
40.00
SS>SSSSSSSSSSSSSSS>S>>>>>>ILLLLLLLLLLLLLLLLLLLL

142.00

Viewing Results

Results may be viewed from within PsychoSig or through a text editor.

Viewing Results in PsychoSig

The data file (datfile) may be viewed from the Output Window when running in
configure mode. Results may be viewed after running a subject or at a later time.

To view results in the Output Window
1. Run PsychoSig in configure mode.
2. Open the PsychoSig file.

3. Choose Output, Text from the View menu.
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The data for all completed conditions will appear in the Output Window.
Results from previous experiments are not displayed in this window, even
though they are stored in the output file.

Viewing Results through a Text Editor

PsychoSig saves data fileddtfiles) in text format. You may view data files
using any text editor.

Note: Great care must be taken when viewing PsychoSig data files through a
text editor. Data may be altered. When possible, use text editors in read-only
mode.

Printing Results

Text data displayed in the Output Window may be printed. You can also
preview the output before printing.

To print result data

1. Display desired data in the Output Window.
Select the Output window by clicking once in it.
Choose Print... from the File menu.

Select the applicable print options for your printer
Press OK.

o~ 0w DN

To preview the result data before printing

1. Select Text from the View Output menu.

2. Select the Output window by clicking once in it.

3. Choose Print Preview from the File menu.

4. Press the Print button and follow steps 4 and 5, above
or

5. Click the Close button to return to the PsychoSig main window.
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Chapter 6 Quick Start Example

The Quick Start example presented in this section illustrates a simple forced-
choice psychoacoustic experiment as designed via PsychoSig. The Quick Start
example is designed to introduce important concepts. Ready-to-use application
files are provided.

Learn New Concepts

The example in this section provides step-by-step instructions you may use to
build the Quick Start example from scratch. Along the way, you will be
introduced to important concepts. These concepts are always indicated with the
icon currently seen in the left margin.

Below is a list of the new concepts introduced in this example.

Example 1: Forward Masking
Value List

Repeat Factor

Boundary Control

Loop

Dynamic Variable

Additive Tracking

Calibration

Get a Quick Start

Completed SigGen and PsychoSig files are provided for the example in this
section. If you prefer, you may use these files, bypassing the step-by-steq
instructions. Quick Start file names are listed at the beginning of the example.
Look for these files whenever you see the Quick Start icon currently displgyed
in the left margin. Instructions for accessing these files and running the
applications appear in boxes and are always located next to a Quick Startficon.
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Example 1:

Forward Masking

This experiment is designed to gather forced-choice psychoacoustic data in
response to two paired stimuli: a 400 millisecond standard stimulus and a 400
millisecond experimental stimulus.

Standard Stimulus

The standard stimulus consists of 300 milliseconds of masking noise presented at
80 dB SPL followed by 100 milliseconds of silence.

Experimental Stimulus

The experimental stimulus consists of 300 milliseconds of masking noise
followed by a tone. Experimental conditions will be created by systematically
varying two parametersDeltaT, the onset of the tone, aRdequencythe
frequency of the tone.

The values for both variables are presented below.

DeltaT Frequency
B 330 milliseconds B 500 Hz
B 310 milliseconds H 1000 Hz
B 300 milliseconds E 3000 Hz

Thus nine experimental conditions will be created.

DeltaT Frequency
1. 330 milliseconds 500 Hz
2. 330 milliseconds 1000 Hz
3. 330 milliseconds 3000 Hz
4. 310 milliseconds 500 Hz
5. 310 milliseconds 1000 Hz
6. 310 milliseconds 3000 Hz
7. 300 milliseconds 500 Hz
8. 300 milliseconds 1000 Hz
9. 300 milliseconds 3000 Hz

For each condition, the value logvel the level in dB SPL of the tone, will vary
dynamically. The initiaLevelvalue will be 80 dB SPL. Following every
incorrect responséevelwill increase by 5 dB. After every correct response,
Levelwill decrease by 5 dB. After three reversals, the valueeélwill be
increased/decreased by 2 dB following incorrect/correct responses. The
experiment will terminate when any of the following conditions occurs:

B 12 reversals
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B 30 trials

B Experiment is aborted

Quick Start
The Quick Start files necessary to run this experiment are as follows:
/ SigGen signal file tdt\siggen\psysig\files\ex1\mask.sig
PsychoSig configuration file tdt\siggen\psysig\files\ex1\mask.pa
C@ To run the experiment, you will need to perform the following steps:
= 1. Build the SigGen Signal.
a. Run SigGen.
Value List b. Define the signal parameters.
Repeat Factor c. Define variables.

B dary Control
ounaary t.ontro d. Create the segments and components.

Loop . .
e. Save the SigGen File.
Dynamic Variable

» _ Configure and run the PsychoSig experiment.
Additive Tracking

R X X X X X X

Calibration a. Run PsychoSig.
b. Assign the SigGen Signal.
Define experimental variable parameters.

c
d. Define experiment parameters.

e. Define interval parameters.
f.  Specify feedback.

g. Enter subject information.
h. Save thepafile.

i. Calibrate the system.

j-  Run the experiment.

Note: Only those parameters to be entered or selected are given below. All
other parameters will remain set to their default values.
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Building the SigGen Signal

In this example, you will use TDT's signal generation software, SigGen, to create
the stimulus signal. You will build one stimulus sigmagsk.sig This signal

will serve as the basis for both the standard signal and the experimental signal.
The duration of the entire stimulus will be 400 milliseconds. The stimulus will
consist of two segments, a 300 millisecond masking noise and a tone presented
at some point during the remaining 100 milliseconds. The standard signal will

be created by setting the level of the tone to 0 dB. Signal parameters will vary as
described in the previous section.

Run SigGen

To run SigGen
» Double-click the SigGen icon.

To build the SigGen signal from scratch

» Choose New from the File menu.

/ To follow along using a Quick Start file

tdtisiggen\psysig| 1. Choose Open from the File menu.
fileslex1\mask.sig o ) .
2. Select the file listed in the left margin.

To bypass the SigGen signal design process

» Exit SigGen by choosing Exit from the file menu and skipésigning
and Running the PsychoSig Experiment.(Look for the Quick Start
icon!).

Define the Signal Parameters

To define the signal parameters
1. Select Signal from the Modify menu of the main window.

2. Enter or select the following parameters in the Signal Parameters dialog
box:

Name: Forward Masking
Sample Period: 2(dseconds
Timing
Duration: 400 milliseconds
Calibration
Level: 90 dB =9 volts

Note: This is a sample calibration
setting. You should set the calibration
values according to the output of your
system.
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Example 1: Forward Masking

3% BB BB

pe Be

Define the Variables

This example will use three variables. The fiBg)taT, will vary the onset of
the tone. The seconBrequencywill vary the tone frequency. The thildgvel
will cause the tone level to vary dynamically.

Controlling Tone Onset

Tone onset will be controlled through use of the varidbédtaT. The values of
this variable will be determined through a method knowviadse List. Value
Listallows you to specify a sequential list of values.

For each value dDeltaT, the tone will be presented at three frequencies. Thus,
aRepeat Factoof 3 must be defined for the varialdeltaT.

Stimulus presentation will be controlled through the use of a feature called
Boundary Contral When boundary control is enabled, the condition is
terminated once the boundary conditions have been exceeded.

To define the variable, DeltaT

1. Click the Edit... button in the Variables group box of the Signal Parameters
dialog box.

2. Enter or select the following parameters in the Signal Variable dialog box:
General
Name: DeltaT
Units: ms
Method: Value List

3. Click Edit List and enter the following: 330
310
300

4. Set the remaining parameters as follows:

Value Limits SGI Modifiers

Default/Start: 330 Repeat Factor: 3
Minimum: 300 Termination Control
Maximum: 330 Boundary Control: ®

To accept the variable parameters and return to the Signal
Parameters dialog box

» Click the OK button in the Signal Variable dialog box.

Controlling Freguency

Tone frequency will be controlled through use of the varidiriequency The
values of this variable also will be determined throughVlee Listmethod.

Because the values Bfequencymust vary for each value BfeltaT, Frequency
must be defined with a Termination ControlLafop.
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To define the variable, Frequency
1. Double-click on 2. .......... in the Variables list box.

2. Enter or select the following parameters in the Signal Variable dialog box:

General
Name: Frequency
Units: Hz
Method: Value List
4. Click Edit List and enter the following: 500
1000
3000
5. Set the remaining parameters as follows:
Value Limits Termination Control
Default/Start: 500 Loop: O]

Minimum: 500
Maximum: 3000

To accept the variable parameters and return to the Signal
Parameters dialog box

» Click the OK button in the Signal Variable dialog box.

Controlling Tone Level

For each condition, the value logvel the level in dB SPL of the tone, will vary
based on subject response. The initelelvalue will be 80 dB SPL.

Following every incorrect respondegvelwill increase by 5 dB. After every
correct responséevelwill decrease by 5 dB. After three reversals, the value of
Levelwill be increased/decreased by 2 dB following incorrect/correct responses.
Because the value bkvelvaries as a function of subject response, it must be
defined as aynamic variable

To define the variable, Level
1. Double-clickon 3. .......... in the Variables list box.

2. Enter or select the following parameters in the Signal Variable dialog box:

General Value Limits
Name: Level Default/Start: 80
Units: dB Minimum: 20
Method: Dynamic Maximum: 100

Note: Itis not necessary to modify the default value of the Step Size field.
Step size will be defined in PsychoSig.

To accept the variable parameters and return to the Signal
Parameter dialog box

» Click the OK button in the Signal Variable dialog box.

To accept the signal parameters and return to the SigGen main
window

» Click the OK button in the Signal Parameters dialog box.
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Create the Segments and Components

Each SigGen signal consists of at least one segment. Each segment in turn
consists of one to three components. In this example, the stimulus consists of
two segments, a masking noise and a tone, each of which consists of one
component.

Creating the Noise Segment

You will be creating a segment that consists of one component, gaussian noise.
SigGen provides a method for gating the noise segment, Gate Type. You will be
defining a Gate Type of Cos2 and a Gate Time of 5 milliseconds.

To create the segment
1. Choose Segment... from the Modify menu.

2. Enter or select the following parameters in the Edit Signal Segments dialog
box:

Select: Seg[1]
Gate Type: Cos2
Gate Time: 5 msec

Duration: 300 msec

Creating the Noise Component

You may generate gaussian noise in either the time domain or the frequency
domain. Generation method is specified in the Gen. Meth field. Time is the
default generation method. Time domain generation is employed in this
example.

Gen. Meth:

|Time |£I

To create a component for the segment
1. Click the first button in the Components group box.

2. Enter or select the following parameters in the Component Parameters
dialog box:

Call: Gauss
Level (dB): 80
3. Click the OK button to accept the component parameters.
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Creating the Tone Segment

You will be creating a second segment that consists of one component, a pure
tone.

To create the segment
1. Click New.

2. Enter or select the following parameters in the Edit Signal Segments dialog
box:

Select: Seg|2]
Gate Type: Cos2
Gate Time: 5 msec

Start:  DeltaT
Duration: 30 msec

Creating the Tone Component

You may generate a tone in either the time domain or the frequency domain.
Time is the default generation method. Time domain generation is employed in
this example.

Gen. Meth:

|Time |£I

To create a component for the segment
1. Click the first button in the Components group box.

2. Enter or select the following parameters in the Component Parameters
dialog box:

Call: Tone
Level (dB): Level
Frequency (Hz): Frequency
3. Click the OK button to accept the component parameters.

To return to SigGen's main window
» Click OK in the Edit Signal Segments (Seg[2]) dialog box.

Save the SigGen File

You will be using this SigGen File to generate a stimulus signal through
PsychoSig.

To save the SigGen file

1. Chose Save from the File menu.

2. EnterCA\TDT\SIGGEN\PSYSIG\FILES\EX1\maskisi¢he File Name
field.
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/

tdtlsiggen\psysig|
fileslex1\mask.pa

Designing and Running the PsychoSig
Experiment

Once you have designed the stimulus signal with SigGen and saved the SigGen
file, you are ready to set up the PsychoSig experiment and begin collecting data.
This example constructs a simple two interval forced-choice experiment. A
standard stimulus and an experimental stimulus each will be randomly assigned
to one of the two intervals. The standard signal will consist of 300 milliseconds
of noise followed by 100 milliseconds of silence. The experimental signal will
consist of 300 milliseconds followed by a tone. The experimental variable will
belLevel the level of the tone. This variable will be tested in nine conditions, as
described previously.

Run PsychoSig

To run PsychoSig
1. If SigGen is running, select Exit from the SigGen File menu.
2. Double-click the PsychoSig icon.

3. Choose® Configure an Experiment from the PsychoSig Startup dialog
box.

4. Enter the configure mode password.
5. Click OK.

Note: To run this experiment, you must either create the PsychoSig file by
following along with the step-by-step instructions or open the existing Quick
Start file.

To use a Quick Start file
1. Choose Open from the File menu.

2. Select the file listed in the left margin.

To bypass experiment setup and begin running the experiment
» Skip toCalibrate the System
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Assign the SigGen Signal

You must assign the desired SigGen stimulus signal.
To assign a SigGen signal
1. Click the signal icon on the toolbar

or
Choose Signal from the Setup menu.

You will see the Load Signal Files dialog box.

Load Signal Files | |

= Channel 1

SigGen File: | | |Brnwse|
= Channel 2

[ Enable

SinGien File: | | |Bml

Cancel

2. Click Browse in the Channel 1 section.

You will see the standard Windows Open dialog box.

Open HE

Lookin: |8 Files

File name: |Mask.sig | I Open I

Files of bype: ISiggen Files [+ zig) EI

3. SelecMask.sigfrom thetdt\siggen\psysig\files\exdirectory.
4. Click the Open button.
5. Click Open in the Load Signal Files dialog to load the file.
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Define Experimental Variable Parameters

Once you have assigned the SigGen stimulus signal, PsychoSig reads the
variable information contained in the signal file and opens the Dynamic Variable
Settings dialog box. You may also access this box by choosing Variable from
the Setup menu.

Dynamic ¥anable Settings [, |

“ariable:  Lewel

- Signal Parameters
- alues

Initial Walue: |20

barValue, [100
MinWalue: |20

= Tracking

et [iadive ]

Initial Step Size:
Final Step Size:

Increment: Incormect
Decrement: Carrect

Iz Final Step: Reverzalz

Stop: Trialz
or Reverzalz

~ Standard Parameters

W ariable Y alue: I:l

PsychoSig has determined from the SigGen file that the dynamic variable is
Leveland that the unit of measurement is dB.

Signal Parameters— Values

The Initial Value, Max Value, and Min Value fields default to those values set in
the SigGen file. You may override these values. This example will use the
default SigGen settings. PsychoSig will begin each trial kétrelset to the

initial value of 80 dB SPLLevelwill not be allowed to exceed the Max Value of
100 dB SPL or to fall below the Min Value of 20 dB SPL.
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Signal Parameters— Tracking

In this example, you will use audditive trackingmethod. This means that the
when the value of Level changes, it will always change by addition or

subtraction of the current step size. PsychoSig defaults the Initial Step Size to 5.
Final Step Size defaults to 2. This example uses the default values. The value
of Levelwill be increased following 1 incorrect response. It will be decreased
following 2 correct responses. The Final Step Size of 2 will take effect after 3
reversals. The condition will terminate after 30 reversals or 12 trials.

Standard Signal Parameters

The standard signal does not contain a tone segment. By setting Variable Value
equal to 0 dB SPL, the tone is effectively eliminated from the standard stimulus.

To set up the variable parameters

» Enter or select the following parameters in the Dynamic Variable Settings
dialog box:

Tracking
Stop: 30 Trials

Standard Parameters
Variable Value: 0

To complete entry of this information
» Click OK in the Dynamic Variable Settings dialog box.

To return to the main window
» Click OK in the Load Signal Files dialog box.

Define Experiment Parameters

You are now ready to define parameters that affect the experiment as a whole.
These parameters include the number of intervals and timing parameters.

In this example, you will be using two intervals. You will present all nine
conditions. Timing parameters will remain at their default settings. No sample
trial will be presented.

Note: You must define a results filed@tfile) prior to running the experiment.
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To define experiment parameters
1. Click the experiment setup icon on the toolbar
or
Select Experiment from the Setup menu of the main window.
2. Enterc:\tdt\siggen\psysig\files\ex1\mask.dathe Results File field.

3. Leave all other parameter settings at their default values.

General Experiment Parameters El

Murnber of Intervals:

= Condition Contral = Sample Trial
@ Automatic O Fresent Sample Trial
b I
g u:;u: scified - Methed
F (2 Play Once
Select Conditions O Flay Continuous
- Conditions

= Timitig

. {2} Befare First Condition
Inter-Stimuluz [ntereal;

(2 Before Al Conditions
) User Specified

mzec

Inter-Trial Inkerval:

] &an
ol =
o =

mzec

|nter-Condition Interval: 00| maec =
i Select Conditions
Stimuluz |ndicator Duration: |400] mzec

- Fesults

Frezults File: |E:"-.TDT'xSigGen'xF's_l,ISig"-.FiIes'\E:-:'I Smaszk. dat | I Brovise |

To return to the PsychoSig main window
» Click OK.

Define Interval Parameters

In the General Experiment Parameters dialog box, you define the number of
intervals. In the Interval Parameters dialog box, you define the interval
interface. Subjects may select intervals by clicking a button on the screen, by

pressing a key on the keyboard, or through interaction with a parallel interface
channel of your choosing.

In this example, you will use the default values for interval parameters.
PsychoSig will automatically place two interval buttons in the Experiment
Window and label them “Interval 1" and “Interval 2.”
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To define interval parameters

1. Click the interval icon on the toolbar

or

Choose Interval from the Setup menu.
2. Click the desired interval button file tab.
3. Make desired changes.

Note: For this example, it is not necessary to make changes to this screen

Interval Properties [ |

Interval 1 I Interyal 2|

= Stirnulus
[ 5Standard Orly

- Button Appearance

= lpper Left Corner Size
<[5 ] Y:—| |-Width: Height;

= Style
oo
O Bitmap I ”Eru:uwsel

- F.eyboard Interface

b ap to Kew:

= Parallel Interface

Output Bit [ Use Megative Logic

Input Bit: IJze Meqative Logic

| Cancel ” Help

To return to the PsychoSig main window
» Click OK.

PsychoSig User's Guide
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Enter Subject Information

You can optionally enter notes about the subject prior to running an experiment.
Subject information is entered from the Subject dialog box.

To enter subject information

1. Click the subject icon on the toolbar

or
Choose Subject from the Setup menu.
2. Enter the desired subject identifier in the Name field.

3. Enter any optional comments.

M armne: |

Comments:

To return to the PsychoSig main window
» Click OK.

Specify Feedback

You may choose to provide feedback for correct and incorrect responses.
Feedback may be visible on the screen, audible through headphones or a
speaker, or may be delivered through a parallel interface channel of your

choosing.

You have been provided with two bitmaps for use as visual feedtigltkbmp
andwrong.bmp

Note: In order to ensure that the feedback does not obscure one or both of the
interval buttons, you must define screen coordinates appropriately.
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To specify feedback

1. Click the feedback icon on the toolbar

or

Choose Feedback from the Setup menu.
2. Check™ Show a Bitmap.
3. Enter the following:.

Upper Left Corner

Y: 50
Size
Width: 50
Height: 30
Bitmap Files

Correct:  c:\tdt\siggen\psysig\files\ex1\right.omp
Incorrect:  c:\tdt\siggen\psysig\files\ex1\wrong.bmp

Feedback [ 3¢ |
Feedback Duration: e

Shaow a Bitmap
= pper Left Corner |' Size

N . ik Height

= Bitmap Files
Corect: | CATDTASighentPapSighFileshEx1h " Browse |

Cancel

Inconect: | CATDTASigGen \PapSig Files\Exh " Browse |

O Plav a Sound

= Sound Files
Correct: | ”Eru:uw*:el
Incomect: | ”Erl:uwsel

[ Light an Led
Fl2 Bitg
Comrect; O Use Negative Logic

Incomect: O Use Negative Logic

To return to the PsychoSig main window
» Click OK.

PsychoSig User's Guide
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Save the Configuration

Once you have set up the experiment, it is a good idea to save the PsychoSig
configuration to a file.

To save the configuration file
1. Click the save icon on the toolbar

or
Choose Save from the File menu.
2. EnterCA\TDT\SIGGEN\PSYSIG\FILES\EX1\maskipthe File Name field.

Calibrate the System

The remaining instructions for this example illustrate the process of data
acquisition and analysis. If you are using a Quick Start file, you must exegute
these step-by-step instructions.

PsychoSig provides several powerful methods of systdilration. You may
calibrate using tones of various frequencies. You may also calibrate the system
through use of the experimental signal or the standard signal.

To access the Calibration dialog box

» Choose Calibrate from the Experiment menu.

Calibration [ ¢ |

- Tohe Calibration

Cahcel
Level: a0 dB S5PL
3 volts
| Play I | Stop |
- Siggen File

90.00dE SPL= 9.00valz= B.36 volts rmsz

F'Ia_l,lSignaIl |F'Ia_l,l5tanu:|an:|| | Stop |

To calibrate using a tone

1. Enter or select the following parameters in the System Calibration dialog
box:

Tone Calibration
Frequency: desired frequency
Level: desired level

When you enter information in the “dB SPL” field, PsychoSig will
automatically change data in the “volts” field to match the relationship
defined in the SigGen file.

PsychoSig User's Guide
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2. Click the Play button to play the calibration tone.

3. Adjust your attenuator until the output equals the amount defined in the
Level field.

4. Click Stop.

To calibrate using a stimulus signal
1. Click Play Signal or Play Standard.

2. Adjust your attenuator until the output equals the amount defined in the
Level field.

3. Click Stop.

To return to the main PsychoSig window
» Click OK.

Run the Experiment

Before running the experiment, you should check the hardware configuration.
Make sure all equipment is properly connected and that the subject is ready to
begin.

Running
You may run from either configure mode or run mode.

To begin stimulus presentation
1. Run PsychoSig in either configure mode or run mode.
2. Make sure that the filmask.pds open.

3. Click the run icon on the toolbar

or

Choose Run from the Experiment menu.

PsychoSig User's Guide
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Interval 1 Interval 2

The screen will turn from blue to green and both interval buttons will depress in
synchrony. This indicates to the subject that the first condition is about to begin.

To begin the first condition
» Have the subject click either interval button.

The subject will be presented with two stimuli, the experimental stimulus and the
standard stimulus. Each of these stimuli will be randomly assigned to one of the
two intervals. As the stimulus is played, the corresponding interval button will
depress, providing the user with visual confirmation of the stimulus interval.

The subject responds by clicking the interval button believed to be correct.
Feedback stating “Right” or “Wrong” will appear in the lower part of the screen
based on the subject’s response.

The first condition will be presented until completed. Upon completion, both
interval buttons will depress in synchrony, indicating to the subject that the next
condition is about to begin.

To begin subsequent conditions
» Have the subject click either interval button.

PsychoSig will continue with the next condition.
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Condition Completion

PsychoSig will run a condition until certain criteria have been met. Trials will
be presented until:

B 12 reversals occur.
B 30 trials are completed.

B The experiment is terminated manually.

Termination of the Experiment

Because you have configured this experiment to execute all conditions
automatically, PsychoSig will continue the experiment until all conditions have
been completed. However, the experiment may be terminated or paused at any
time.
To manually terminate the experiment
» Click the abort icon on the toolbar

or

Choose Abort from the Experiment menu.

To pause the experiment

» Click the pause icon from the toolbar

or

Choose Pause from the Experiment menu.
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